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Up and Down: Vertical Oscillations – ID: 
10541 
By Irina Lyublinskaya 
 

Time required 
45 minutes 

 

Topic: Circular and Simple Harmonic Motion 
• Use the equations of motion to find frequency, period, force, energy, velocity, and 

acceleration of objects in simple harmonic motion.  
Activity Overview 
In this activity, students explore vertical oscillations produced by a mass attached to an elastic 
spring and collect data on the force of the spring as a function of time. Students then explore the 
relationship between the period of oscillations and the magnitude of the oscillating mass, fit a 
model to their collected data, and apply the model to solve problems. 
 

Materials 
To complete this activity, each student will require the following: 

• TI-Nspire™technology 
• Vernier Dual-Range Force sensor 
• Vernier EasyLink™or Go!®Link interface
• stand (rod and base) and clamp 
• elastic spring 

• slotted weight set with hanger 
• copy of student worksheet 
• pen or pencil 
• blank sheet of paper 

TI-Nspire Applications 
Lists & Spreadsheet, Graphs & Geometry, Data & Statistics, Notes, Calculator 

Teacher Preparation 
Students should be familiar with the concept of simple harmonic motion and with the fact that, in 
the absence of air resistance, small oscillations of a mass attached to an elastic spring 
represent simple harmonic motion.  

• Before carrying out this activity, you should review with students Newton's second law 
and Hooke’s law. This will help students set up the equation describing the motion of the 
spring-mass system. You may also want to review the equation for simple harmonic 
motion. 

• The screenshots on pages 2–8 demonstrate expected student results. Refer to the 
screenshots on page 9 for a preview of the student TI-Nspire document (.tns file). The 
student worksheet is shown on pages 10–12. 

• To download the .tns file and student worksheet, go to education.ti.com/exchange 
and enter “10541” in the search box. 

Classroom Management 
• This activity is designed to be student-centered, with the teacher acting as a facilitator 

while students work cooperatively. The student worksheet guides students through the 
main steps of the activity and includes questions to guide their exploration. Students 
may record their answers to the questions on blank paper or answer in the .tns file using 
the Notes application.  

• The ideas contained in the following pages are intended to provide a framework as to 
how the activity will progress. Suggestions are also provided to help ensure that the 
objectives for this activity are met.  

• In some cases, these instructions are specific to those students using TI-Nspire 
handheld devices, but the activity can easily be done using TI-Nspire computer software.  
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The following questions will guide student exploration during this activity: 
• What are the forces that act on the oscillating mass? What causes oscillations in the 

spring-mass system?  
• What is the relationship between the period of oscillations and the oscillating mass? 

Can you model this relationship mathematically? Does your model agree with the 
theoretical results? 

The purpose of this activity is to allow students to observe the vertical oscillations of a mass 
attached to an elastic spring and explore the dynamics and kinematics of this case of simple 
harmonic motion. Students collect data on the force of the spring as a function of time, 
analyze these data, and measure the period of oscillations for various masses. They observe 
changes in the spring force for each mass and determine the period of oscillations by either 
tracing the graph or by using the regression capabilities of TI-Nspire technology. Students 
then develop a mathematical model for the relationship between mass and period and apply it 
to solve problems. 

If time allows, students can determine the spring constant of the spring used in the activity by 
measuring displacement as mass is added to the spring at rest. The force constant is the 
slope in the graph of force (mg) vs. displacement. Otherwise, you should provide students 
with the value of the spring constant so that they can compare their mathematical models with 
the theoretical formula for the period of oscillation. 

Problem 1 – Collecting force data 

Step 1: Students will use a Vernier EasyLink (if 
using a handheld) or Go!Link (if using a computer) 
interface connected to a Vernier Dual-Range Force 
sensor to collect force data. Make sure the switch on 
the force sensor is in the ±10N position. Students 
should set up the experiment as shown to the right 
and explained in the worksheet. They should practice 
pulling and releasing the spring several times to 
initiate vertical linear oscillations before collecting 
data. 

Step 2:  Students should connect the Dual-Range 
Force sensor to the EasyLink or Go!Link interface. 
Once the experimental setup is complete, students 
should answer questions 1 and 2. 

Q1. What are the forces acting on the oscillating 
mass?  

A. the force of gravity (the weight of the spring 
and mass) and the spring force (restoring force 
of the spring) 

 

clamp Dual-
Range 
Force 
sensor utility 

handle 
spring 

mass 
hanger 
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Q2. Draw a free-body diagram for the spring-mass 
system, and use Newton's second law to set up 
the equation describing its oscillation. 

A. A sample free-body diagram for a mass in 
equilibrium (i.e., not moving) is shown below: 

 
A free-body diagram for a mass in motion is 
shown below: 

 
If x0 is the position of the bottom of the spring 
at equilibrium, x is the displacement of the 
bottom of the spring from equilibrium, k is the 
spring constant, m is the total mass of the 
spring-mass system, W is the weight of the 
system, and a is the acceleration of the spring, 
then according to Newton's second law, 

0 . Because 0W , the 
final equation for the motion of the spring is the 
following: 

 

− − + =kx kx W ma kx=

− = + =
k

kx ma, or  a x
m

0  

 

 

 

 

 

 

 

 
W = mg 

F = –kx0

 

 

 

W = mg 

F = –kx 

a 
 

 

Step 3: Students should open the file 
PhyAct_10541_UpDown.tns, read the first two 
pages, and then move to page 1.3. When students 
reach page 1.3, they should connect the EasyLink or 
Go!Link interface to their handheld or computer. This 
should activate the force sensor, and a force display 
should appear in the data collection box on page 1.3. 
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Step 4: Before students carry out data collection, 
they should clear any data stored in the device 
(Menu > Data > Clear All Data) and zero the sensor 
(Menu > Sensors > Zero). Note that the spring-mass 
system should be in equilibrium (i.e., not moving) 
before students zero the sensor. 

 

Step 5: The “play” button (►) should be highlighted 
in the data collection box. If this is the case, students 
need only click (press a) to begin data collection. If 
the play button is not highlighted, students should 
press e until it is selected. They should then pull 
the mass down slightly, release it, and then begin the 
data collection. When data collection has finished, the 
scatter plot will be displayed on the graph. Students 
should then answer questions 3–6. 

Q3. Describe the shape of the graph. 

A. The graph has the shape of a sine or cosine 
function. 

 

Q4. What is the meaning of a positive force on this 
graph? What is the meaning of a negative 
force? 

 

A. A positive force represents a stretching 
(extension) of the spring from the equilibrium 
position. A negative force represents 
compression of the spring from the equilibrium 
position. 

Q5. Describe the motion of the mass when force 
has its maximum value and minimum and zero 
values. In which direction does the mass move 
in each instance? How is the slope of the curve 
related to the motion of the mass? 

A. The mass is at rest at the bottom position when 
force reaches maximum and is at the top 
position when force reaches minimum. When 
force is zero, the mass is moving through the 
equilibrium position. When the slope of the 
force vs. time graph is positive, the mass is 
moving down, and when slope is negative, the 
mass is moving up. 
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Q6. What is the period of oscillations? What mass 
is attached to the spring? 

A. Answers will vary. Students can trace the graph 
to determine the period of oscillations. 

 

Problem 2 – Modeling the period of oscillations 

Q7. What will happen to the period of oscillations if 
you increase the mass attached to the spring? 

A. Student answers will vary, but many students 
will probably predict that a larger mass will lead 
to a larger period of oscillation. Encourage 
students to discuss and justify their predictions, 
and encourage more specific predictions than 
simply “period will increase.” An example of 
such a prediction is “the period will increase in 
direct proportion to the increase in mass.” 

Step 1: Next, students should read the text on page 
2.1 and then move to page 2.2. Page 2.2 shows a 
Graphs & Geometry page with a data collection 
display. If the data collection display is not present, 
students can insert it by pressing /D. 

Step 2: Students should place additional mass on 
the hanger, record the total mass of the spring-mass 
system, and repeat steps 4 and 5 from problem 1. 
They should record the mass and the oscillation 
period on their worksheets. 

 

Step 3: Students should repeat step 2 for several 
more masses. They should record data for at least 
five masses. They can use the data from problem 1 
as one of the data points. 
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Step 4: Next, students should move to page 2.3, 
which contains a Lists & Spreadsheet application and 
a Data & Statistics application. Students should 
record the data they collected in steps 2 and 3 in the 
Lists & Spreadsheet application (mass in column A 
and period in column B). A corresponding scatter plot 
will appear on the graph to the right of the data. If all 
the data do not appear in the Data & Statistics 
application, students can resize the window (Menu > 
Window/Zoom > Zoom-Data). Students should 
study the graph and then answer questions 8–10. 

Q8. What mathematical model would you use to 
best fit these data? 

A. The data are consistent with a power 
relationship (i.e., y = xk). Many students will not 
correctly identify the relationship. Encourage 
students to try several different regressions in 
order to identify the correct fit. 

Q9. Find the mathematical model for the period of 
oscillations. 

A. For the sample data shown, the best-fit 
equation is . Students should 
use the Power Regression tool (Menu > 
Analyze > Regression > Show Power) to 
determine the best-fit equation for their data.  

= 0.492y 3.320x
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Q10. Use the spring constant of your spring to 
determine the theoretical relationship between 
period and mass. How close are your 
theoretical results to your experimental results? 

A. The spring used to collect the sample data has 
a spring constant of 3.4 N/m. The formula 
describing the theoretical relationship between 
period (T), mass (m), and spring constant (k) is 

2π=
m

T
k

. Substituting for the value of k, we 

get 
π

= = 0.52 m
T 3.

3.4
4m . The error is about 

2% between the experimental and theoretical 
results, as shown below: 

% = %

% = %

−

−

i

i

3.4 3.32
100 2.3

3.4
0.5 0.492

100 1.6
0.5

 

 

Problem 3 – Applications and problem solving 

Step 1: Next, students should answer questions 11 
and 12. A Calculator application is given on 
page 3.1 for students to use to solve these 
problems. 

 

Q11. An elastic cord vibrates with a frequency of 
3.0 Hz when a mass of 0.60 kg is hung from it. 
What is its frequency if only 0.38 kg hangs from 
it? 

 

A.  The period of oscillations is proportional to 
m . Therefore, frequency is inversely 

proportional to m . This leads to the equation 

1

= 12

2

mf
f m

. Solving this equation for f2 yields 

Hz. =2f 3.8

Q12. At equilibrium, a mass of 0.262 kg stretches a 
vertical spring 0.315 m. If the spring is 
stretched an additional 0.130 m and released, 
how long does it take to reach the equilibrium 
position again? 
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A. The spring constant can be found from the 
equilibrium condition, when the spring force 
(kx) is equal to the weight (mg), as shown 
below:  

( )(
=

)
=

= =
2

kx mg

mg 0.262 kg 9.8 m/s
k 8

x 0.315 m

 

.15 N/m
 

The period of oscillation is therefore 

=π π −= = 1m 0.262 kg
T 2 2 1.13 s

k 8.15 N/m
. It takes 

one-quarter of a period for the spring to return 
to the equilibrium position, so the time is 
0.28 sec. 

Step 2: Next, students should move to page 3.2, 
which is set up for data collection. They 
should connect the Dual-Range Force 
sensor, zero it, and collect data to answer 
question 13. Students may also use the 
Calculator application provided on page 3.1. 

Q13. Collect another set of data for vertical oscillations. Determine the amplitude of the 
oscillations. What is the total distance the mass travels in one period of oscillations? 

A. The sample data shown above are for m = 0.050 kg. To determine the amplitude of 
oscillations, first find the maximum force by tracing the curve. The maximum force is the 

average of the minimum and maximum points on the curve: 
+

=
0.16 0.18

0.17 N
2

. 

According to Hooke's law, F = kx; therefore, the maximum displacement (x), or 

amplitude, of the oscillation is given by =
F

x
k

. Solving this equation with the given data 

yields the following: 

== =
F 0.17

x 0.05 m
k 3.4

  

The amplitude of the oscillation is 0.05 m. In one period, the mass travels four 
amplitudes' worth of distance (two up and two down), so the total distance traveled is 
0.2 m. As a point of interest, you may wish to explain that tides follow the same 
harmonic pattern and that scientists use measurements of the height of the water level 
to examine tides and the various phenomena that influence tides, such as hurricanes 
and winter storms. Real-world data and more information can be found on the Internet. 
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Up and Down: Vertical Oscillations – ID: 10541 
 (Student)TI-Nspire File: PhyAct_10541_UpDown.tns 
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Name  ____________________________ Up and Down: Vertical 

Oscillations 
ID: 10541 

Class  ____________________________ 

 

 
In this activity, you will explore the following: 

• how the force exerted by an elastic spring changes with time during 
vertical oscillations of a mass attached to the spring 

• how the period of oscillations depends on the mass attached to the 
spring 

• the mathematical model of simple harmonic motion 

In this experiment, you will study simple harmonic motion. Consider a mass attached to an elastic 
spring. If you pull the mass down slightly and then release it, the mass will move up and down (oscillate). 
If resistance is small (as it generally is for highly elastic springs), these oscillations will continue for a 
long time. We call these oscillations “free oscillations.” The period of oscillations, T, is the time it takes 
for the mass to complete a full cycle and return to the same point, moving in the same direction. The 

period of oscillations, T, is the reciprocal of the frequency of oscillations (that is, =f
T

1
). The motion of 

the mass on an elastic spring is called simple harmonic motion, and it is described by the sine or cosine 
function.  

In this activity, you will collect spring force data with a force sensor, analyze these data, and measure 
the period of oscillations for various masses. You will then develop a mathematical model for the period 
of oscillations and apply it to solve conceptual problems. 

Problem 1: Collecting force data 

Step 1: Use the clamp to mount the utility handle of the Dual-Range Force 
sensor (the threaded aluminum rod) so that the utility handle is horizontal. 
Mount the force sensor on the utility handle with the hook pointing down. 
Tighten the thumb screw to fix the sensor in position. Attach an elastic 
spring to the hook at the bottom of the force sensor. Place the mass 
hanger on the other end of the spring, as shown in the diagram to the right. 

Step 2: If you are using the TI-Nspire handheld for data collection, connect 
the Dual-Range Force sensor to the EasyLink interface. If you are using 
TI-Nspire computer software to collect data, connect the Dual-Range 
Force sensor to the Go!Link interface. Do not connect the EasyLink or 
Go!Link interface to the handheld or computer yet. 

Q1. What are the forces acting on the oscillating mass?  
Q2. Draw a free-body diagram for the spring-mass system, and use 

Newton's second law to set up the equation describing its oscillation. 

 

 

 

 

Step 3: Open the file PhyAct_10541_UpDown.tns on your handheld or 
computer. Read first two pages and move to page 1.3. Connect the 
interface to your handheld or computer. This should activate the force 
sensor, and a force display should appear in the data collection box on 
page 1.3.  

clamp 
Dual-
Range 
Force 
sensor 

mass 
hanger 

utility 
handle 

spring 
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Step 4: Before you carry out the data collection, clear any data stored in 
the device by pressing b and selecting Data > Clear All Data. Next, 
zero the sensor. To do this, make sure the spring is in equilibrium (not 
moving), and then press b and select Sensors > Zero.  

Step 5: The “play” button (►) in the data collection box should be 
highlighted. If it is not, press e until it is highlighted. Then, pull the mass 
down slightly, release it, and click (press a) to begin the data collection. 
When the data collection has finished, a scatter plot will be displayed on 
page 1.3. After data are collected, close the data collection box. 

Q3. Describe the shape of the graph. 
Q4. What is the meaning of a positive force on this graph? What is the 

meaning of a negative force? 
Q5. Describe the motion of the mass when force has its maximum value 

and minimum and zero values. In which direction does the mass 
move in each instance? How is the slope of the curve related to the 
motion of the mass? 

Q6. What is the period of oscillations? What mass is attached to the 
spring? 

 

Problem 2: Modeling the period of oscillations 

Q7. What will happen to the period of oscillations if you increase the 
mass attached to the spring? 

Step 1: Read the text on page 2.1, and then move to page 2.2. Page 2.2 
shows a Graphs & Geometry application with a data collection display. If 
the data collection display does not appear, press /D to insert it.  

Step 2: Place additional mass on the hanger, record the total mass, and 
repeat the data collection (steps 4 and 5 in problem 1).  

Step 3: Repeat step 2 for several more masses. Record your data in the 
spaces below. 
m2 = ______ kg, T2 = ______ s 

m3 = ______ kg, T3 = ______ s 

m4 = ______ kg, T4 = ______ s 

m5 = ______ kg, T5 = ______ s 

 
 

 

 

 

 

 

Step 4: Move to page 2.3, which contains a Lists & Spreadsheet 
application and a Data & Statistics application. Record the masses and 
periods you measured in steps 2 and 3 above in the Lists & Spreadsheet 
application. Record masses in column A and periods in column B. As you 
enter the data, a scatter plot will appear in the Data & Statistics 
application. 

Q8. What mathematical model would you use to best fit these data? 
Q9. Find the mathematical model for the period of oscillations. 
Q10. Use the spring constant of your spring to determine the theoretical 

relationship between period and mass. How close are your 
theoretical results to your experimental results? 
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Problem 3: Applications and problem solving 

The equation of motion for the spring-mass system is − = +
k

kx ma,  a x
m

or 0= , where k is the spring 

constant, x is displacement from equilibrium, m is mass, and a is acceleration. The period of motion (T) 

for the system is given by the equation π=
m

T
k

2 . In this part of the activity, you will compare your 

mathematical model for the period of oscillations with this formula and apply what you learned about 
oscillations to problem solving.  

Step 1: Page 3.1 contains a Calculator application that you can use to 
solve questions 11 and 12. 

Q11. An elastic cord vibrates with a frequency of 3.0 Hz when a mass of 
0.60 kg is hung from it. What is its frequency if only 0.38 kg hangs 
from it? 

Q12. At equilibrium, a mass of 0.262 kg stretches a vertical spring 
0.315 m. If the spring is stretched an additional 0.130 m and 
released, how long does it take to reach the equilibrium position 
again? 

Step 2: Next, move to page 3.2, which contains a Graphs & Geometry 
page. Insert a data collection box by pressing /D. Zero the force 
sensor and then collect the data necessary to answer question 13. 

Q13. Collect another set of data for vertical oscillations. Determine the 
amplitude of the oscillations. What is the total distance the mass 
travels in one period of oscillations? 

 
 

 


